scrp-manual Documentation
Release 1.0.0

Sergey Kritskiy

Aug 18, 2023






Contents:

10

11

12

13

Installation 5
1.1 Assigningto Hotkey . . . . . . . . . . e e 5
1.2 Hotto find scripts for editing? . . . . . . . . . ... 6
Scriptorator Settings 7
2.1 Managing sCriptS . . . . . v i e e e e e e e e e e e e e e e e e e e e e e 8
Quick Select 9
3.1  Working with Clown (Material ID) pass . . . . . . . . . o v i i ittt e e e e 9
3.2 OPHONS .« . v v o i e e e e e e e e e e e e e e e e e e 10
Guides maker 11
N N © J o () 12
Layer to Selection 13
Split Layer to Islands 15
Fill Contour 17
7.1 Newin L1 . oo o e e e e e e e 17
T2 OPHONS . . . o ottt e e 19
Path from Layer/Selection 21
Quick Resize 23
FG to Modified Color 25
10.1 OPpHONS . . . v v vt e e e e e e 26
FG to inverted BG color 27
T1.1 OpHoONS . . . o o o o e e e e e e e e 28
Smart Layer Mask 29
12,1 Optons . . . . . oot e e e e 30
Select Brush 31
13,1 OpHONS . . . o o v o e e e e e e e e e e e e e e e e e e 32




14

15

16

17

18

19

20

21

22

23

24

25

26

27

28

29

30

31

32

33

34

Set Brush Size
T4 1 OptONS . . v v o ot e e e e e e e e e e e e e e e e e e

Set Brush Rotation
I5.1 OPpHONS . . . o o v vt e e e e e e e e e e

Set Brush Opacity
16.1 OPpHONS . . . . o v vt e e e e e e e e e e e

Set Brush Flow
I7.1 OPpHONS . . . . o vttt e e e e e e e

Set Brush Roundness
I18.1 OpUONS . . . o o v ot e e e e e e e e e e e e

Set Brush Hardness
19.1 OpUONS . . . o o v ot e e e e e e e e e e e e e e e e e

Smart Objects: Selected to Smart Objects
Smart Objects: Reset

Smart Objects: Unpack Selected
Smart Objects: Rasterize All
Switch Between Layer and Mask
Smart Eraser

Break a Paragraph to Lines
Transform Layers by a Path

Set Text Alignment

Create Custom Shape

Show Blending Options

Select Random Brush
311 OptONS . . o v v o o e e e e e e

Create a Gradient from Path
32,1 OPHONS . . v v v i e et e e e e e e e e e e e e e e e e e e e

Merge to Smart Object
33,1 OPLONS . . v v o i e e e e e e e e e e e e e e e e e e e

Release Log

34.1 5Dec2022: Scriptorator 1.5 . . . . . . . L e e e e e e e e
342 19 Dec 2019: Scriptorator 1.4 . . . . . . .. L
343 24 Sep 2018: Scriptorator 1.3 . . . . . L. e e
344 21 Aug2019: Scriptorator 1.2 . . . . . . .o e e
34.5 4 Mar 2019: Scriptorator 1.1 . . . . . . . . . o e e e e e e e e e e e
34.6 9 Oct 2018: Initial release of Scriptorator . . . . . . . . . . . it e e e e e e

33
34

35
36

37
38

39
40

41
42

43
44

45

47

49

51

53

55

57

59

61

63

65

67
67

69
69




scrp-manual Documentation, Release 1.0.0

Scriptorator is a free collection of scripts that I use in my workflow all the time (and obviously some of them will
be useless for people with different worflows). Most of these scripts are extended or automatised versions of existing
Photoshop functions. If you feel there’s something should be added here or have a request for a script, just let me
know. For the moment, Scriptorator contains:

* Quick Select: it’s like Color Range but hides this ugly selection afterwards + allows to quickly select Material
Pass areas;

* Guides maker: create guides around/in the center of a layer(s) or a selection;

e Layer to Selection: quickly load a selection based on layer bounds;

» Split Layer to Islands: create a separate layer for each pixel island (new in 1.1);

* Path from Layer/Selection: create a path based on layer(s) bounds or a selection;

e Fill Contour: quickly fill an outline with a foreground color;

* Quick Resize: quickly resize the document by pixels, percents or based on active layer or selection size;

* FG to modified color: to change foreground color (new in 1.1);

* FG to inverted BG color: for brushes with Foreground/Background color dynamics;

e Smart Layer Mask: quickly add/remove/apply layer masks;

e Select Brush: assign brush or tool presets to hotkeys;

Contents: 1
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* Set Brush Size: use several copies of this script with different values to quickly switch between particular sizes
for any painting tool;

* Set Brush Rotation: set a rotation (relative or absolute) for the current painting tool (new in 1.1);

* Set Brush Opacity: set an opacity (relative or absolute) for the current painting tool (new in 1.1);

* Set Brush Flow: set a flow (relative or absolute) for the current painting tool (new in 1.3);

* Set Brush Roundness: set a roundness (relative or absolute) for the current painting tool (new in 1.2);

* Set Brush Hardness: set a hardness (relative or absolute) for the current painting tool (new in 1.2);

e Smart Objects: Selected to Smart Objects: convert the selected layers to smart objects (new in 1.1);

e Smart Objects: Reset: undo all modifications made to smart object (new in 1.1);

e Smart Objects: Unpack Selected: unpack selected smart objects to layers (new in 1.1);

e Smart Objects: Rasterize All: rasterize all smart objects in the current document (new in 1.1);

» Switch Between Layer and Mask: switch between layer and layer mask (new in 1.1);

* Smart Eraser: switch between the active tool and eraser, setting the eraser tool to the same size as the brush
tool;

2 Contents:
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* Break a Paragraph to Lines: break a paragraph to separate lines of text (new in 1.2);

o Set Text Alignment: change text alignment without changing layer coordinates (new in 1.4);

» Transform Layers by a Path: to help with precise scaling and rotating layers using paths as guides (new in 1.2);

* Create Custom Shape: create custom shapes from documents and selections (new in 1.4);

» Show Blending Options: show Layer Blending Options window (new in 1.4);

e Select Random Brush: select a random brush from a specific group (new in 1.5);

* Create a Gradient from Path: use a path to create a gradient of specific width (new in 1.5);

* Merge to Smart Object: merge layers into a smart object (new in 1.5);

* Fill with Pattern: fill a selection or the whole document with a specific pattern (mostly for sampling with Mixer)
(new in 1.5);

e Scriptorator Settings: to rule them all (new in 1.1);

Contents: 3
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Scriptorator Settings

Scripts

Create Guides: Border

File infa... Duplicate

Script Interface with a modifier

Shortout

Mone

Send to Brusherator

Contact me at kritskiy.sergey @ gmail.com Twitter: @ebanchiki Grab the scripts on my Gumroad or Cubebrush

Contents:
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CHAPTER 1

Installation

1. Close Photoshop

2. To install:
* Run .exe file from Windows Install or . pkg file from Mac Install folders to install the scripts;
* Or copy * . jsx files from Manual Install to Scripts folder of your Photoshop;

If you want to make several copies of particular scripts (like Select Brush or Set Brush Size) don’t forget to change
name of the script (inside the .jsx file, inside the <name> tag) so yuo won’t confuse the copies.

1.1 Assigning to Hotkey

To assign scripts to shortcuts:
1. Start Photoshop and navigate to Edit > Keyboard Shortcuts menu;
2. Select a Keyboard Shortcuts tab;
3. In Shortcuts For field select Application Menus;

4. InApplication Menu Command find all the scriptsin File > Scripts and assign desired shortcuts
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Keyboard Shortcuts and Menus X

Keyboard Shortcuts Menus

Shortcuts For:  Application Menus ’ Set:  Photoshop Defaults (modified) ~ Cancel

Use Legacy Channel Shortcuts

Shortcut

Add Shortcut

Delete Shortcut
Ctrl+F1 Summarize...
Shift+Ctri+F1
Smart Layer Mask Sh Ctrl+R
Alt+Shift+Ctrl+R

For scripts that use modifier keys, assign two hotkeys (using the Add Shortcut button): one without the modifier
and second one with the modifier. On the image above Smart Layer Mask and Quick Select have two hotkeys assigned,
shift is a modifier key for Quick Select and it’s alt for Smart Layer Mask.

1.2 Hot to find scripts for editing?

Scripts are installed to the Scripts folder of any found Photoshop. To get to this folder navigate to

C:\Program Files\Adobe\Adobe Photoshop CC 2018\Presets\Scripts for Windows
Applications\Adobe Photoshop CC 2018\Presets\Scripts for MacOs

6 Chapter 1. Installation



CHAPTER 2

Scriptorator Settings

Scriptorator Settings is a special script added in 1.1, used specially for changing settings and managing scripts.

Scriptorator Settings

Scripts

Create Guides: Border Send to Brusherator

File infa... Duplicate

Settings
Show Script Interface with a modifier

Shortout Mone

You can access it in several ways:
e throughFile > Scripts > ! Scriptorator Settings Photoshop menu item;
 through Edit > Search Photoshop menu item, typing ! and selecting ! Scriptorator Settings;

* if you have Brusherator installed, flyout menu includes Scriptorator Settings item;
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2.1 Managing scripts

The first row of buttons:
* Select a script you want to modify from the list;

* Send to Brusherator: if Brusherator is installed, a current script will be added to an active shelf of any
Brusherator;

The second row allows you to manage script file:

e File Info... will show a window with options to copy file path to clipboard and open Scripts folder in file
explorer;

* Duplicate will make a copy of a current script with a new name. Use this to create several instances of scripts
with different settings;

* Rename will rename a current script;
* Delete will remove a current script;

Last 3 options may be greyed out if Photoshop doesn’t have access to its Presets/Scripts folder. To give PS
access:

e on Mac:

— make sure Applications/Adobe Photoshop CC XXXX/Presets/Scripts folder isn’t
set to Read Only;

¢ on Windows:
— retake ownership of the folder (https://superuser.com/a/1141616/971910);

— OR simply restart PS as Administrator:

Open

Open file location

E;' Run as administrator

8 Chapter 2. Scriptorator Settings
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CHAPTER 3

Quick Select

This function is used to create selections from visible layers or a Clown (Material ID) pass, selection will stay hidden;
Modification of Color Range. .. command from Select menu; To quickly select areas of a color or areas from
Clown (Material ID) pass; Best used when assigned to a hotkey (mine is Ct r1+F1, with Shift as a Clown modifier)

An example of selecting an area of color.

Note that selection (marching ants) is hidden and doesn’t obstruct the view (this is optional though).

3.1 Working with Clown (Material ID) pass

If the current document has a layer with a word clown in it, Quick Select will enable this layer when showing the
Color Range dialogue.
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An example of selecting a part of Clown pass. There’s a layer with c1own in its name in my document, so when using
Quick Select with a key modifier, Clown pass is shown while selecting and then hidden.

3.2 Options

Scriptorator Settings

Scripts
Quick Select
Send to Brusherator Duplicate
Setlings
Default Fuzziness
Hide Selection After Executing

Smooth ID Map selection

Select from an ID Map with a modifier

Shortout

e Default Fuzziness: default value for Fuzziness;

* Hide Selection After Executing: hide selection after clicking OK;

* Smooth ID Map selection: if used with a clown layer: smooth it a little bit;

* Select from an ID Map with a modifier: key modifier for using a clown layer;

* Shortcut: shows a shortcut assigned to the function;

10 Chapter 3. Quick Select



CHAPTER 4

Guides maker

This function contains of 3 scripts:
1. Create Center Guides
2. Create Border Guides
3. Remove All Guides

This function is used to create guides around borders or in a center of selected layer(s) or selection; Guides then may
be used for symmetry, to align layers, etc; Create guides manually Select a layer, several layers of make a selection;
Best used when placed on Brusherator

Additional script interface allows to select a specific guide to be created. In this example left guide is used to drive a
Quick Symmetry function of Layer Factory:

11
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4.1 Options

Scriptorator Settings

Scripts

Create Guides: Border

Send to Brusherator Duplicate

Settings

Show Script Interface with a modifier Cirl

Shortout Mone

* Show Script Interface with a modifier: key modifier for showing the function interface (option

may be set separately for Border and Center guides makers);

e Shortcut: shows a shortcut assigned to the function;

12

Chapter 4. Guides maker



CHAPTER B

Layer to Selection

This function creates rectangular or elliptical selection based on active layer bounds; Manually make a selection;
Rectangular to visualize layer bounds; Elliptical to create a precise selection for existing elliptical object or to recreate
existing bad ellipse layer; Best used when placed on Brusherator

An example of creating a selection based on existing ellipse: on a temporary layer I'm marking edges of the ellipse,
than I use Layer to Ellipse Selection and remove the temp layer:

13
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14 Chapter 5. Layer to Selection



CHAPTER O

Split Layer to Islands

This function will create a separate layer for each pixel island; Cutting the layers manually Best used when placed on
Brusherator;

15
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16 Chapter 6. Split Layer to Islands



CHAPTER /

Fill Contour

This function will fill all closed figure on a bitmap layer with a foreground color; Manually selecting and filling or
painting the region; To quickly fill a painted contour, especially userful for brushes with jagged strokes;

Additional script interface allows to set gap size and an option to create the fill as a separate layer:

7.1 New in1.1:

Option to control the amount of silhouette contracting, useful when contour isn’t 100% opaque:

17



scrp-manual Documentation, Release 1.0.0

Layer to fill Contract Fill by: 4 Contract Fill by: 0

Fill Contour

Options:
Contract Fillby: 0]
Create Mew Layer for the Fil

Fill Gaps

Gap width: 3

et As Default

18 Chapter 7. Fill Contour
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7.2 Options

Scriptorator Settings

Scripts

Fill Conbour

Send to Brusherator Duplicate

Settings

Show Script Interface with a modifier Cirl

Shortout Mone

* Show Script Interface with a modifier: key modifier for showing the function interface;

e Shortcut: shows a shortcut assigned to the function;

7.2. Options 19
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20 Chapter 7. Fill Contour



CHAPTER 8

Path from Layer/Selection

This function will create a rectangular, rounded rectangular or elliptical path around selected layer(s) or selection;
Manually creating a path; To create specific paths and shapes from predefined selections or raster layers; Best used
when placed on Brusherator

21
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22 Chapter 8. Path from Layer/Selection



CHAPTER 9

Quick Resize

This function is used to quickly resize active document based on percents, pixels, current layer/selection or just to
change resolution; Image Size menu To quickly resize image, Quick Resize almost completely replaced Photoshop
Image Size menu for me; Best used when assigned to a hotkey (mine is Home)

Quick Resize has 4 modes:
* Percent
* Pixels
* Resolution Only

* By Layer (of Selection) (to resize document so that current layer/selection would be particular size)

In Windows it’s possible to quicky switch between modes with A1t +Q/W/E /R hotkeys, MacOS unfortunately doesn’t
support this. Resizing is done suing the Bilinear filtering. Resizing By Layer/Selection is approximate,
resulting Layer may be 1-2 pixels larger/smaller in the end.

An example of resizing based on selection so that the sphere would become 200px wide:

23
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24 Chapter 9. Quick Resize



cHAaPTER 10

FG to Modified Color

This function is used to modify Foreground Color; Changing the color manually, using Color Panel; Best used when
there’re 2 copies — with positive and negative values — that are assigned to hotkeys (mines are F5, F'6)

I use those to slightly modify Hue of the foreground color in both directions, maintaining color Lightness:

25
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10.1 Options

Scriptorator Settings

Scripts

FG to modified color
Send to Brusherator Duplicate
Settings
Hue Shift Add

Saturation Multiply

Brightness Multiply

Modifier key w | Add
Modify Property Hue
Preserve Lightness

Shortout Mone

e Hue Shift: Default Add of 15;

e Saturation: Default Multiply of 1 = no changes;

e Brightness: Default Multiply of 1 = no changes;

* Modifier key: key modifier for additionally changing any property;

* Modify Property: additional property to be changed when modifier key is used;

* Preserve Lightness: with this option turned ON, lightness of a color won’t be modified;

e Shortcut: shows a shortcut assigned to the function;

26
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cHAPTER 11

FG to inverted BG color

This function is used to change Background Color to inverted Foreground color (in RGB space), (or any other color,
really);IbriChanging the color manually; To get an appropriate color for brushes with Foreground/Background expres-
sion turned on; Best used when assigned to a hotkey (mine is Ctr1/Cmd+")

I love brushes with FB/BG expression in Color Dynamics turned on. However usually I have White color as a BG
color so they add a lot of white to canvas. In this case I use this function to get a more beutral color as a BG color.

27
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11.1 Options

Scriptorator Settings

Scripts

FG to inverted BG color
Send to Brusherator Duplicate
Settings
Hue Shift Add « | 180

Saturation Multiply

Brightness Multiply

Modifier key
Modify Property
Preserve Lightness

Shortout Mone

* Hue Shift: Default Add of 180 = opposite color in RGB;

e Saturation: Default Multiply of 0.5 = two times less saturation;

e Brightness: Default Multiply of 0.5 = same brightness;

* Modifier key: key modifier for additionally changing any property;

* Modify Property: additional property to be changed when modifier key is used;

* Preserve Lightness: with this option turned ON, lightness of a color won’t be modified (new in 1.1);

e Shortcut: shows a shortcut assigned to the function;

28
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cHAPTER 12

Smart Layer Mask

This function acts both as adding and removing layer masks, one hotkey + modifier executes 4 functions: reveal selec-
tion, hide selection, apply and remove layer mask, works with several layers selected; Using 4 Photoshop commands,
repeating for each selected layer; To quickly add/remove layer mask; Best used when assigned to a hotkey (mine is
Ctrl/Cmd+Shift+Rand A1t as a modifier)

If layer doesn’t have a layer mask and there’s a selection:
» Using SLM will create a layer mask, hiding unselected area, revealing the selection;

» Using SLM with modifier key will create a layer mask, hiding selected area;

If layer has a layer mask:
» Using SLM will apply the layer mask;

» Using SLM with modifier key will remove the layer mask;

29
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12.1 Options

Scriptorator Settings

Scripts

Smart Layer Mask

Send to Brusherator Duplicate

Setlings

Use a modifier Alt

Shortout Shift+Cirl+R7

* Use a modifier: key modifier for additional functionality mentioned above;

e Shortcut: shows a shortcut assigned to the function;

30 Chapter 12. Smart Layer Mask



cHAPTER 13

Select Brush

This function will select a specific tool or brush preset; This is similar to selection a preset with Action and may be
assigned to a hotkey with a difference that Action hotkeys are limited to F-keys. Plus it’s possible to set Preserve Size
option Best used when assigned to a hotkey; Copy the script several times to use it with different presets

Quickly selecting different brushes with hotkeys:

31
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13.1 Options

Scriptorator Settings

Scripts

L=

Select Brush: preset name

Send to Brusherator Duplicate
Setlings
Preset Type
Preset Name
Preserve Brush Size

Shartout

Preset Type: select type of a preset: brush or tool preset;

Preset Name: type name of the preset;

Toal Preset

Mone

Preserve Brush Size: with this option turned ON size will be inherited from previous tool;

Shortcut: shows a shortcut assigned to the function;

32
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cHAPTER 14

Set Brush Size

This function will set a particular size for current painting tool (brush, mixer brush, eraser, dodge... you name it)
Manually switching to a particular size, expecially painful when you need to go from 2 to 2000; Make as many copies
for different sizes as you need and place them on Brusherator or hotkeys

33
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14.1 Options

Scriptorator Settings

Scripts

Set Brush Size: 30

Send to Brusherator Duplicate

Setlings

Set Tool Size

Modifier key

Shortout Mone

* Set Tool Size: type the size value;
* Modifier key: modifier key can be used to additionaly change the size value. Modified setting will ignore

the one set above;

* Shortcut: shows a shortcut assigned to the function;

34 Chapter 14. Set Brush Size



cHAPTER 15

Set Brush Rotation

This function will set a rotation (relative or absolute) for the current painting tool (brush, mixer brush, eraser, dodge. . .
you name it) Manually switching to a particular rotation; Make as many copies for different rotation values as you
need and place them on Brusherator or hotkeys

In this example two Rotation scripts set to add 90 and -90 rotation on C1ick and 180/-180 on Ctr1+Click:

35
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15.1 Options

Scriptorator Settings

Scripts
Set Brush Rotation: 30

Send to Brusherator Duplicate

Setlings
Set Brush Rotation Add w90

Maodifier key v | Add « | 180

Shortout Mone

* Set Brush Rotation: type the rotation value;
e Modifier key: modifier key can be used to additionaly change the rotation value. Modified setting will

ignore the one set above;

* Shortcut: shows a shortcut assigned to the function;

36 Chapter 15. Set Brush Rotation



cHAPTER 16

Set Brush Opacity

This function will set an opacity (relative or absolute) for current painting tool (brush, eraser, dodge... you name it)
Manually switching to a particular opacity; Make as many copies for different opacity values as you need and place
them on Brusherator or hotkeys

In this example there’re four copies of Set Brush Opacity: two relatively add/subtract 15% of opacity of Click
and 30% on Ctr1+Click and two set opacity ot 50% and 100%:

37
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16.1 Options

Scriptorator Settings

Scripts

Set Brush Opadty: 100%

Send to Brusherator Duplicate

Setlings

Set Brush Opadity 100

Modifier key

Shortout Mone

* Set Brush Opacity: type the size value;
* Modifier key: modifier key can be used to additionaly change the size value. Modified setting will ignore

the one set above;

* Shortcut: shows a shortcut assigned to the function;

38 Chapter 16. Set Brush Opacity



cHAPTER 17

Set Brush Flow

This function will set a flow (relative or absolute) for a current painting tool (brush, mixer brush, eraser, dodge... you
name it) Manually switching to a particular flow; Make as many copies for different flow values as you need and place
them on Brusherator or hotkeys

39
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17.1 Options

Scriptorator Settings

Scripts

Set Brush Flow: 100% Send to Brusherator

File infa. .. Duplicate

Setlings
Set Brush Flow 100
Modifier key

Shorteut Mone: Click to assign

Reset to Default

e Set Brush Flow: type the size value;
* Modifier key: modifier key can be used to additionaly change the size value. Modified setting will ignore
the one set above;

* Shortcut: shows a shortcut assigned to the function;

40 Chapter 17. Set Brush Flow



cHAPTER 18

Set Brush Roundness

This function will set a roundness (relative or absolute) for the current painting tool (brush, mixer brush, eraser,
dodge...) Manually switching to a particular roundness; Make as many copies for different roundness values as you
need and place them on Brusherator or hotkeys

In this example there’re four copies of Set Brush Roundness: two relatively add/subtract 15% of roundness of
Click and 30% on Ctr1+Click and two set roundness ot 50% and 100%:

41
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18.1 Options

Scriptorator Settings

Scripts

Set Brush Roundness: 100%;

File info... Duplicate

>ettings
Set Brush Roundness

Modifier key

Shortout

* Set Brush Roundness: type the roundness value;

2end to Brusherator

Set Yalue 100

Reset to Default

* Modifier key: modifier key can be used to additionaly change the roundness value. Modified setting will

ignore the one set above;

* Shortcut: shows a shortcut assigned to the function;

42
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cHAPTER 19

Set Brush Hardness

This function will set a hardness (relative or absolute) for the current painting tool (brush, mixer brush, eraser,
dodge...) Manually switching to a particular hardness; Make as many copies for different hardness values as you
need and place them on Brusherator or hotkeys

In this example there’re four copies of Set Brush Hardness: two relatively add/subtract 15% of hardness of
Click and 30% on Ctr1+Click and two set hardness ot 50% and 100%:

43
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19.1 Options

Scriptorator Settings

Scripts

100%; 2end to Brusherator

Set Brush Hardness:

File info... Duplicate

>ettings
Set Brush Hardness Set Value w 100
Medifier key

Shortout Mone

Reset to Default

* Set Brush Hardness: type the hardness value;
e Modifier key: modifier key can be used to additionaly change the hardness value. Modified setting will

ignore the one set above;

* Shortcut: shows a shortcut assigned to the function;

44 Chapter 19. Set Brush Hardness



cHAPTER 20

Smart Objects: Selected to Smart Objects

This function will convert the selected layers to smart objects; converting layers one by one; Best used when placed
on Brusherator;

45
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46 Chapter 20. Smart Objects: Selected to Smart Objects



CHAPTER 21

Smart Objects: Reset

This function will undo all modifications made to smart object; None; Best used when placed on Brusherator;

47
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48 Chapter 21. Smart Objects: Reset



CHAPTER 22

Smart Objects: Unpack Selected

This function will unpack selected smart objects to layers; None: manually opening and dragging layers from smart
objects; Best used when placed on Brusherator;

49
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50 Chapter 22. Smart Objects: Unpack Selected



CHAPTER 23

Smart Objects: Rasterize All

This function will rasterize all smart objects in the current document; Rasterizing the smart objects one by one; Best
used when placed on Brusherator;
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52 Chapter 23. Smart Objects: Rasterize All



CHAPTER 24

Switch Between Layer and Mask

This function will switch between layer and layer mask; Clicking the icons of layer/layer mask; Best used when
assigned to a hotkey;
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CHAPTER 25

Smart Eraser

This function will toggle between current tool and eraser tool, preserving a size of a brush so the eraser wouldn’t be
too small or large; Manually switching between tool and adjusting an eraser size manually; Best used when assigned
to a hotkey (mine is E replacing the standard Eraser hotkey)
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CHAPTER 20

Break a Paragraph to Lines

This function will convert a paragraph of text to separate text layers based on line breaks Manually breaking and
moving layers to specific coordinates; To individually control lines of the text paragraph Best used when placed on
Brusherator

In this example I break the paragraph to apply a gradient effect separately to each line:
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CHAPTER 27

Transform Layers by a Path

This function will help to precisely scale and rotate layers using paths as guides to place it to match a specific trans-
formation by entering the free transform with set pivot and scale; Manually scaling and rotating layers to match the
required transformations; to precisely scale and rotater layers; Best used when placed on Brusherator

* placing a one guide path will offset the active layer(s) and set a pivot to the second point of the path;

* placing two guides will offset the active layers(s), set a pivot to the second point of the first path and scale the
layer(s);

In this example I’'m matching an viewport render of my model with an existing flat version of that model that was
scaled and rotated:
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CHAPTER 28

Set Text Alignment

This function will change text alignment while keeping the layer coordinates; Moving a text layer after changing a text
alignment; to change text alignment without hustle; Best used when placed on Brusherator

In this example I"'m changing text alignment from Center to Left to continue typing:
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CHAPTER 29

Create Custom Shape

This function will create a custom shape from an active document or selection with a preview; Doing all the things
manually; To have more control over the custom shape settings; Best used when placed on Brusherator

In this example I’m creating a shape from a selection. Note the Treshold slider for previewing a custom object and an
ability to invert the object before creating it:

If cancelled during the Treshold phase, a document duplicate with the adjustment layer won’t close: it’s possible to
edit out the unwanted parts and run the function again to finish the custom shape creation:
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cHAPTER 30

Show Blending Options

Quickly showing the layer Blending options; The same as double-clicking the layer; Place on a hotkey to quickly call
the window;

Simple as that, just a way of showing the Blending Options window;
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CHAPTER 31

Select Random Brush

This will select a random brush from a specific group; None; To randomly go through texture brushes

31.1 Options

* Group Name: the name of the group to select a brush from;

Description is coming soon. . .
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CHAPTER 32

Create a Gradient from Path

This will create a gradient of a set length perpendicularly to a path None; Useful for creating gradients in perspective;

32.1 Options

* Gradient Width: length of the gradient in pixels;

e Limit the Gradient Length to Paths: with this option on the gradient length will be limited to the
drawn path;

* Delete Paths: to delete the paths after the function was called;

* Create as Smart Objects: the layers will stay as Smart Objects. This is useful for modifying the
perspective or the gradient itself;
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CHAPTER 33

Merge to Smart Object

This will add all the selected normal layers into the selected non-transformed smart object;/brlManually copying and
realigning everything. . . ; To quickly add more content into existing SOs;

Note that currently this function won’t work properly on transformed smart objects;

33.1 Options

* Close SO:to close the original Smart Object;
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CHAPTER 34

Release Log

34.1 5 Dec 2022: Scriptorator 1.5

* New scripts: Select Random Brush, Create Gradient from Path, Merge to Smart Object, Fill with Pattern;

* Installers updated to support latest Photoshop versions;

Fill Contour script settings were moved into the Scriptorator Settings;

* Fixed bugs;

34.2 19 Dec 2019: Scriptorator 1.4

* New scripts: Change Text Layer Alignment, Create Custom Shape from Document, ID Pass to Layers;
* Installers updated to support Photoshop 2020;
* Installers will remove readonly flag from Scripts folder of Photoshop;

« Fixed: unability to set hotkeys to specific keys using the Scriptorator Settings;

34.3 24 Sep 2018: Scriptorator 1.3

* it’s possible to assign script hotkeys directly from Scriptorator Settings script;

e New scripts: Set Brush Flow;

34.4 21 Aug 2019: Scriptorator 1.2

* New scripts: Set Brush Roundness, Set Brush Hardness, Break Paragraph to Lines, Transform by Path;
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* Scripts updated to latest versions;

34.5 4 Mar 2019: Scriptorator 1.1

» New scripts: Split Layer to Islands, FG to modified color, Set Brush Rotation, Set Brush Opacity, Smart Objects:

Selected to Smart Objects, Smart Objects: Reset, Smart Objects: Unpack Selected, Smart Objects: Rasterize
All, Switch Between Layer and Mask, Scriptorator Settings;

* Scripts updated to latest versions;

* Settings won’t be overwritten on updates;

34.6 9 Oct 2018: Initial release of Scriptorator
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